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Declaration of Conformity

Manufacturer: Cambridge Sensotec Limited
Unit 29 Stephenson Road
St Ives
CAMBS
PE27 3WJ
Product Names: Rapidox portable oxygen gas analyser
Model Numbers: RX 1100LR
Conform to the following specifications:

EMC: EN 61326:1998 Electrical equipment for measurement,
control and laboratory use

Declaration: I declare that the above products conform to the applicable
requirements of the LVD Directive 73/23/EEC and the EMC Directive 89/336/EEC

and is CE marked accordingly.

Signature:

Name: Dr. Mark Swetnam

Title: Managing Director
Company: Cambridge Sensotec Limited
Date: 1% August 2010

WEEE Regulations 2006

Regulations extremely seriously and has taken steps to be compliant in
line with our corporate and social responsibilities. In the UK,
Cambridge Sensotec has joined a registered compliance scheme
“WeeeCare” (WeeeCare registration number WEE/MP3538PZ/SCH).

E Cambridge Sensotec takes its responsibilities under the WEEE

UK users only: If you have purchased any electronic or electrical product from
Cambridge Sensotec since 2007 and would like to dispose of it correctly under the
WEEE scheme, please contact us and we will be happy to either arrange the
collection of the waste or have it returned to our offices for recycling. All our in-
house manufactured products are scheme compliant and carry the WEEE label
indicating that it is NOT allowed to be disposed of in a landfill site.


http://www.weeecare.com/
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1. Introduction

The Rapidox 1100LR oxygen analyser allows accurate oxygen analysis over the
range 0.1ppm to 1% O, using a special German-engineered ppm electrochemical
oxygen cell. This special low range analyser is designed for applications where a
traditional zirconia sensor is not suitable. This includes applications where the
measurement gas contains VOCs, solvents, fuels, helium or hydrogen.

The analyser provides continuous on-line oxygen analysis, with a typical response
time less than three minutes for a response from 1% down to 1000ppm. Below
10ppm response times are considerably longer due to the way electrochemical
sensors work.

The analyser is fitted with a special cell holder which allows the reading to
stabilise as quickly as possible, and is fully temperature and pressure
compensated for enhanced accuracy. The cell is very sensitive to exposure to high
concentrations of oxygen, including air, and to prevent damage the unit is fitted
with a solenoid valve to keep the cell in the measurement gas at all times; even
when switched off.

The analyser contains a powerful diaphragm pump that draws a gas sample at a
flow rate set by the user, of between zero and approximately 1.2 litres per minute.
An on-board pressure sensor compensates for any pressure changes in the sample
gas. Alternatively the pump can be independently switched off and operated
under flowing gas conditions.

The analyser includes two fully programmable alarm circuits (volt-free contacts),
programmable analogue outputs (0-10V and 4-20mA), easy calibration (using 2
user-selectable gases), RS232/RS485 communications and a full set of
communications / data-logging software.

2. Features

<\

Continuous gas sampling via powerful internally located pump, which can be
independently switched off for the unit to be operated without the pump.

Accurate oxygen analysis in hydrogen, helium and gases containing solvents.
Measurement range available 0.1ppm to 10,000ppm (1%) oxygen.

Accuracy better than + 2% of reading or +0.5ppm, whichever is greater.
Easy to calibrate by the user using any two gases.

0-10V and 4-20mA current loop outputs (user programmable).

RS232 / RS485 data-output.

Windows data logging software with MS-Excel compatible data file output.

N N N N N N N

Programmable alarms with outputs (volt-free contacts) and audible and visual
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warnings.
v" Works on any worldwide mains voltage 90-260 Vac.

v Printer and transport Peli-case options.

3. Specification

3.1 Rapidox Dimensions & Power Requirements

Case dimensions: W=250mm; D=263mm; H=150mm. Weight=4kg. Metal
carrying handle supplied as an option. Runs on any Worldwide voltage 90-
260VAC 50/60Hz. Power consumption is 12W maximum.

3.2 Accuracy and Resolution

Sensor response time is typically 180 seconds from 10,000 ppm down to 1000ppm
and 5 hours from 10ppm to 1ppm. High accuracy is maintained between
calibration points. Accuracy is +2% of the reading or +0.5ppm, whichever is
greater. Maximum resolution is 0.1ppm.

3.3 Display

The analyser has a 2-line 16x2, 9mm character, back-lit liquid crystal display
(LCD) , whose data update rate is user-programmable. The LCD displays up to
four significant figures of oxygen (O,), with a maximum resolution of 0.1ppm.
The display notation (auto-percent or ppm) is user selectable.

3.4 Calibration

The simple and fully flexible calibration procedure requires two calibration gases.
The calibration gas compositions are user-selectable and programmed into the
Rapidox via the keypad menu or the RS232 link and configuration software.
Factory pre-sets can be reloaded to allow the unit to be rescued' from a failed
calibration. The Rapidox is calibrated using the keypad on the front panel or
directly with the software provided. The LCD changes to calibrate mode to inform
the user of progress.

3.5 Operating Temperature & Pressure

Gas inlet temperature must not exceed 50°C. The Rapidox unit’s normal operating
temperature is 5-35°C. Normal operating pressure is 600 to 1750mbar absolute.
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3.6 Outputs

The RS232 serial port (RS485 is available on request) outputs on demand values
for oxygen (ppm), the internal temperature and pressure sensor data (temperature
in °C, pressure in bar), time (hh:mm:ss) and date (dd/mm/yy). This data can be
downloaded and logged using the software provided.

Standard 0-10V and 4-20mA analogue outputs are available on the rear panel for
both O, and either temperature or pressure (user-selectable), as are two voltage-
free reed relay alarm signals. These outputs are fully user-programmable either
via the front panel keypad or the supplied configuration software using the RS232

link.

4. Technical Specification

Property Specification
Supply Voltage 90-260VAC, 50/60Hz
Power consumption 12W (max)
Analyser dimensions 250mm X 263mm X 150mm
Weight 4 kg
Display 16 x 2 character (9mm) back-lit LCD

Warm up time

5 minutes at 20°C

Normal operating temperature

5-35°C

Operating pressure range

600 to 1750mbar absolute

Sensor range

0-10,000ppm (0-1%)

Sensor accuracy

+29% of the reading or +£0.5ppm, whichever
is greater

Outputs: O, & temperature or pressure

0-10V (user-programmable) into minimum
5kQ

O, & temperature or pressure

4-20mA current loop (user-programmable)
into maximum 5000

Programmable alarms

Relay circuits — fully user-programmable

All data and parameters

RS232 (or RS485) - data streamed on
demand

Sample Pump

Mains type diaphragm vacuum pump
(variable flow) with on/off switch on rear
panel.

Flow Rate

Typically 0-1.2 L.min" in 10 steps

Max. gas temperature at input

50°C

Calibration

Requires 1 or preferably 2 user-selectable
gas compositions

Table 1: Technical specification

5. Precautions

Make sure you read and understand these instructions and keep them safe for later
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use. The unit should not be exposed to extreme temperatures < -5°C or > 60°C.
Normal operating temperature is 5-35°C. Avoid direct sunlight. Do not use liquid
cleaners, aerosols or solvents to clean the case. Use a damp cloth for cleaning. Do
not use this equipment near water. Avoid touching the LCD display as this may
cause permanent damage. Make sure the rear ventilation slots and the fan on the
rear panel are free of obstruction.

There are no user-serviceable parts in this unit. Do not attempt to repair yourself.
Refer all servicing to qualified Cambridge Sensotec personnel.

6. Warning

This unit is NOT designed for use in life support situations. No responsibility can
be held for injury or loss of life caused by inappropriate use of this equipment.

7. Rapidox Operating Instructions

cambrige T
sensotec

5 i

ESC||ENT || E=p

s [ 3DIAOX 1100

Figure 1: Rapidox 1100LR front panel. Numbers are referred to in the text.
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Figure 2: Rapidox 1100LR rear panel. Numbers are referred to in the text.

7.1 The Rapidox Analyser - Menu System

All of the user-programmable functions are accessed via a menu system which is
controlled using the front panel Keypad (2). To access the menu press the ENT
button and to escape and return to the operating screen press ESC at any time.
The menu system flow chart is shown in Appendix 1 at the back of the manual.

7.2 Getting Started

Ensure that the Rapidox analyser is located away from extreme heat and dirt
environments. Plug the unit in to a suitable supply (noting the information on the
serial sticker and using the power cable supplied) using the rear power socket (8).
Make sure that the cooling fan (9) is not obstructed during operation.

Turn the unit on using the red power switch on the front (5). The LCD (1) will
display the serial number and firmware version for a few seconds before
measurements begin. The sensor will take approximately five minutes to stabilise.
The LCD display will show the oxygen reading and either the temperature,
pressure or date and time (user-selectable). The symbol AL1 or AL2 may appear
to the bottom right of the LCD if the alarm system is enabled and an alarm
condition applies.

Push the gas sample tube (6mm OD/4mm ID) into the GAS IN (3) quick release
connector. Repeat for the GAS OUT (4) connector should an outlet tube be
required. The pump will draw gas at a flow rate depending on the value set either
in the software or from the menu. The default setting is OFF.

Version 1.6 5 Last printed 16/11/2011 16:53:00



Cambridge Sensotec Rapidox 1100LR Oxygen Analyser Instruction Manual

Allow five minutes for the Rapidox to stabilise fully. If the sensor has been
exposed to air or the gas composition is greater than 3% oxygen then the message
“O/Range” will appear on the display. Below 3% oxygen but above 1% the display
will read the maximum value of 10500ppm (or 1.05%) but will flash until the gas
mix goes below 10500ppm, when normal readings will begin. Flush the analyser
with your measurement gas and wait a few moments for the readings to come on
scale.

7.3 Pump Control

The flow rate of gas drawn into the analyser can be controlled using the menu
option 2 “Set Pump Flow”. The unit is supplied with the flow rate set to OFF. If
you wish to change the flow rate press ENT and select menu option 2. Use the UP
& DOWN arrows to change the value from OFF to 100% in 10% increments. 100%
equates to approximately 1.5 litres per minute. Once you have selected the
desired flow rate, press ENT to confirm your selection. If you do not press ENT,
the pump will revert to the previous rate when the unit exits the menu system.
When using the unit with a pressurised (flowing) gas source the pump can be left
switched off.

7.4 Menu Access / Passwords

The analyser has an option to set a password that will restrict access to the menus.
The password menu is disabled by default in the factory. If you wish to password
protect the analyser press ENT and scroll down to the PASSWORD option (menu
option 12). Pressing ENT again will ask you for the default password which is
“0000”. Enter this using the UP and DOWN arrows. Once the password has been
entered successfully you can choose between ENABLE and DISABLE in the menu
using the UP and DOWN keys.

The other option is to CHANGE the password to a new value. The password must
be 4 digits long and can be any combination of numbers from 0000-9999. Make
sure that the new password is noted down!

If the password function has been enabled then in the future each time the menu
system is accessed, the password prompt will display. After the correct password
is entered then the full menu will be accessible. You can make as many changes
as you want to the menu options and only press ESC once you have finished.
Pressing ESC takes you out of the password protected area and you will have to re-
enter the password to go back in again.

If the password has been forgotten please contact Cambridge Sensotec who will
advise you on how to recover it.

7.5 Rapidox Calibration

Once the unit is at temperature it may be necessary to calibrate the sensor. Full
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calibration is a simple procedure requiring only one or two gases. The two gas
values are user-selectable and can be changed via the front keypad (2) or the
communications software described in section 8, and the calibration values can be
stored on file for later use. It is suggested that one cal gas is set between 1000 and
10,000ppm and the other cal gas is set between 10 and 1000ppm. Below 10ppm
the sensor takes many hours to stabilise so calibration could become very slow.
Factory calibration is done at 10,000ppm and 100ppm.

The procedure is as follows:

1) Bearing in mind the points made above, decide which two gases you are
going to use for calibration. If you are constantly working at a particular
range of compositions then it would be wise to obtain small cylinders of
calibration gas with analysis certificates. Cambridge Sensotec can supply
these. Press the ENT button on the front panel keypad (2) to access the
menu system. Using the UP and DOWN arrow buttons scroll to menu
option 1 “Calibrate” and press ENT again to enter the calibration menu.
Use the UP and DOWN arrows to select “O, High” or “O, Low” and press
ENT to proceed. The top line of the display shows the current calibration
gas stored and the bottom line of the display shows the prompts. If the gas
value is not what you require you can edit the value (in ppm scientific
notation) using the up and down and right arrows on the keypad. The
cursor flashes underneath the digit to edit. For example 1000ppm should
be entered as 1.000E+03ppm. Note that you can not go backwards to edit a
digit to the left of the cursor. Instead keep pressing the RIGHT button and
the cursor will wrap around back to the beginning. Alternatively press ESC
to start again. Press ENT when you are ready to proceed.

2) The sensor needs to be exposed to the first calibration gas from a cylinder
of known composition. For accurate calibration it is important to allow
sufficient time to pass to flush the sensor properly. Wait for the top line of
the display (1) to become stable. The time this takes depends on the
oxygen concentration of the gas: for 1% oxygen about 5 minutes should
suffice, but for 100ppm it may be necessary to wait for about 30 minutes.
To complete the calibration press and hold the ENT button for two seconds.
During this time you will see a bar graph progress across the lower display.
The analyser will then recalibrate and display “O, Calibrated” and then
return to normal run mode. The display will now correctly read the value
of the first calibration gas. Note that if the ENT button is released before
two seconds have elapsed, the recalibration will be aborted and when the
analyser eventually returns to run mode it will use the existing calibration.

3) Note that the analyser should ideally be calibrated at normal ambient
pressure and at the temperature at which it will be used. If the pressure
correction mode is set to AUTO then it is still possible to perform an
accurate calibration at pressures other than ambient. If the gas temperature
is significantly different from the ambient temperature, allow the gas to
flow for sufficient time for the sensor temperature to stabilise fully before
calibrating.
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4) The analyser predicts the correct signal from the sensor during calibration
and if this is outside the range of expected values then the display will flash
and display “G?” to warn you that either the cal gas flowing over the sensor
is different to the value you have programmed OR the sensor may be old
and approaching the end of its life. Check before proceeding!

5) To calibrate using the second calibration gas, repeat the procedure from 2
but this time press ENT followed by the UP or DOWN button to scroll
through to the “O, Low” screen. Flush the sensor chamber with the second
calibration gas allowing several minutes for the new gas to flush through.
Wait for the display to become stable before pressing the ENT button for
two seconds. The analyser will then recalibrate and display “O, Calibrated”
and then return to normal run mode. The display will now correctly read
the value of the calibration gas.

6) The analyser is now correctly calibrated and will read accurately between
these two calibration points. Note that this procedure can also be
performed remotely using the software described in section 8.

7) If at any time, you encounter difficulties and wish to restore the machine to
its factory set calibration, use the configuration software provided and load
the original factory settings (described in section 7.17 below). Each
machine is provided with a unique file that contains the factory settings.
This is located on the CD-ROM provided and is copied onto your PC during
the installation process.

8) Note that the two calibration points are independent of each other so you
can calibrate the analyser in any order you desire. However please note
that ‘O, High’ must always be greater than ‘O, Low’. Typically the factory
settings are ‘O, High’ = 10000ppm and ‘O, Low’ = 100ppm.

NB You must always perform a FULL calibration to achieve good accuracy.

7.6 Alarms

The Rapidox is fitted with two independent and fully programmable alarm relay
outputs, which can be programmed to be either normally open (N/O) (closes on
alarm) or normally closed (N/C) (opens on alarm). You have the option of
assigning each alarm to the oxygen, pressure (internal) or temperature sensors, as
well as enabling the alarm relay circuits, enabling an audible buzzer and enabling
a visual warning on the screen.

The alarms can be programmed by the user via the keypad (2) on the front panel
or using the software provided (see section 8.5.3). To change the alarm settings
scroll down the menu to option 3 “Set Alarms” and press ENT. Now use the UP &
DOWN arrows to select “Alarm 1” or “Alarm 2” and press ENT. The next screen
shows the message “Assign To:” followed by the currently assigned parameter.
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Use the UP and DOWN arrows to select O,, temperature (of the gas) or pressure
depending on which measurement you want the alarm to work with, and press
ENT to proceed. The default is O,.

The next settings configure the behaviour of the alarm. Use the UP & DOWN
arrows to select ON or OFF for the following parameters:

1. OUTPUTS: This enables the rear panel relay outputs when ON is selected

2. AUDIBLE: This enables or disables the audible buzzer inside the unit
which will sound in an alarm condition

3. VISIBLE: This enables or disables warning messages on the LCD screen on
the front of the Rapidox. During an alarm condition either “AL1” or “AL2”
(or a combination of both) will flash at the bottom right hand corner of the
display.

4. POLARITY: This determines whether you are setting a rising or falling
alarm. Use the arrows to change the direction of the alarm to up or down.
A rising alarm means that the alarm will be silent at values below the set-
point but as soon as the value rises above the set-point the alarm will be
triggered

5. SETPOINT: The current alarm set-point is displayed in scientific notation
with a flashing cursor under the first digit. Use the UP & DOWN arrows to
change the digit and the RIGHT arrow to progress until the correct value is
displayed. When done, press ENT to proceed to the next setting.

6. CONTACTS: The relay outputs can be set to either normally open (N/O) or
normally closed (N/C). The factory default is N/O, meaning the contacts
will close when an alarm condition occurs. Press ENT to save all the above
settings for the selected alarm.

Alarm 2 can be set in exactly the same way as described above and both alarm
circuits are completely independent of each other. Note that you must programme
all the parameters for each alarm for the settings to be saved. The bottom line of
the LCD will display “Alarm x set” (where ‘X’ is the selected alarm channel) to
confirm that the settings have been saved.

The alarm circuit relays are accessed via the terminal block on the rear panel and
are clearly labelled. Alarm 1 is assigned to the terminals labelled “Alarm High”
and Alarm 2 is assigned to the terminals labelled “Alarm Low”. The relay circuit
is rated at 24V 0.5amps maximum.

The alarm limits for oxygen are set to a minimum of -100ppm and a maximum of
30,000ppm. Under certain conditions (e.g. the sensor becomes disconnected) the
Rapidox will set the alarm channel to OFF to prevent false alarms, and the relay

contacts for the affected channel will go to the programmed N/O or N/C setting.
For more information please refer to Table 2 in section 7.7 below.

7.7 Analogue Outputs

The standard industrial analogue outputs (0-10V and 4-20mA) for both oxygen
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and pressure are accessible via the terminal block (6) on the rear panel. Note that
the ranges of the 0-10V and 4-20mA are tied together so changing one alters the
other. In the case of oxygen, the outputs are factory set to provide a linear
response in the range 0-10,000ppm that will cover most applications. However
the lower and upper values are fully user-programmable using the keypad (2) or
the software provided (section 8). A more details description is given below:

The linear oxygen output mode setting produces an output that is scaled linearly
between 0 and 10V (or 4 and 20mA). So, for example, if the scale is set 0V =
Oppm (0%) O, and 10V = 10,000ppm (1%) O, then 5V would indicate an oxygen
reading of 5000ppm (0.5%) O,. The scaling of this example is shown in the
following plot, from which other intermediate values can also be read.

"Lin(ppm)"
Linear output mode
10 + 20
8.75 | 18
75 | 16
3 ! =
2625 | 14 5
o T S
o
2 57 112 <
o T IS
> 3.75 | 10 o
o T @)
2.5 ] 1lg
1.25 & 6
O :: T T T T T T T T T 4
0 01 02 03 04 05 06 07 08 09 1
O, (%)

Figure 3: Graph showing the linear output mode option for oxygen

The following general formulae can be used to calculate the oxygen from the
voltage or current outputs when set to the linear output mode:

Output type | Formula for calculating oxygen from analogue output signal
0'1OV Oz = Voul/ 10 * (OZH = OZL] + OZL
4-20mA 0, =(mA,—4)/16 * (O, - Oy) + Oy,

Where: O,,, = user setting of oxygen for 0V or 4mA output *

0, = user setting of oxygen for 10V or 20mA output *
V,. = the measured voltage output in volts
mA,, = the measured current output in mA

1 0,, 0, and O, must all be in the same units.

To modify the oxygen analogue output range scroll down the menu to no.3 “Set
Outputs” and press ENT. You can now edit the lower and upper values in exactly
the same manner as described in 7.5 for setting the cal gas values. Once
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programmed the new values remain in the memory until they are edited again in
the future.

To select and modify the auxiliary outputs (pressure) scroll down to menu option
3 “Set Outputs” and pres ENT four times. Use the up and down arrow buttons to
program the pressure scale and press ENT. The permissible range is -2000mbar to
+2000mbar.

During initial warm up of the Rapidox when the display reads the serial number
the output sent to the rear terminal for oxygen will stay at 2mA (1V) which is the
standby signal. If at any stage a sensor becomes disconnected internally, or the
signal exceeds the measurable range for that sensor, then the display will indicate
there is a fault and the outputs will change to 1mA (0.5V) which is the sensor fault
signal. This will recover as soon as the sensor is reconnected and the fault
cleared. Additional current and voltage signals are provided by the analyser to
give an indication of various conditions and these are described in Table 1 below,
together with the status of the alarms during the condition:

O, Analogue Outputs
Current® Voltage® Description Explanation Alarms “
(4-20mA) (0-10V)
There is a sensor fault on the oxygen
sensor, and/or the temperature sensor
has a fault condition, and/or the
1mA 0.5v Fault pressure mode is set to automatic De-activated
(pressure compensation active) and
the pressure sensor has a fault
condition.
2mA v Start up The analyser is still initialising. De-activated
2.5mA 1.25V Sensor under range The sensor reading is under range. Active
3mA 1.5V Sensor over range The sensor reading is over range. Active
The sensor reading is in range but the
temperature sensor reading is out of
3.5mA 1.75v Sensor operating out of range, and_/or the pressure mode i; set Active
specification to automatic (pressure compensation
active) and the pressure sensor is out
of range.
The O, sensor and associated ™
4 to 20mA 0to 10V Normal operating output sensor(s) are operating normally and Active
readings are in range.
Aux Analogue Outputs
Current® Voltage® Description Explanation Alarms “
(4-20mA) (0-10V)
1mA 0.5v Fault The assigned sensor has a fault. De-activated
2mA v Start up The analyser is still initialising. De-activated
2.5mA 1.25V Sensor under range :;neggsagned sensor reading is under Active
3mA 1.5V Sensor over range ;I';negzsagned sensor reading is over Active
4 to 20mA 0to 10V Normal operating output The assigned sensor is operating Active
normally and readings are in range.
Table 2: Analogue output settings and alarm status for certain conditions
Notes:
1 “Associated” sensors are the temperature sensor and the pressure sensor (when pressure mode is set to automatic).
2 The current outputs are active self-powered outputs - they are not loop powered.
3 The voltage (0 to10V) outputs produce non-zero voltages during start-up, fault and over/under range conditions - if

1V to 5V outputs are required, with these conditions indicated by corresponding voltages between 0V and 1V, the
current outputs can be used, with a 250 Ohm load resistor.
4 Alarms are de-activated during start up initialisation, and when a fault condition occurs on the assigned sensor.
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7.8 Setting the Display Units

The notation used by the display is fully programmable to suit your needs using
the keypad (2) or the software provided (section 8.5.1). The following options are
available to you:

1. Oxygen: The oxygen reading can be displayed in percent (e.g. 1.000%), or
ppm (e.g. 1.0ppm) If percent is selected the Rapidox will display oxygen as
a percentage down to 0.01% and in ppm below this value.

2. Temperature: The reading can be displayed in °C or °F

3. Pressure: The reading can be displayed in mbar, bar, psi, torr or kPa.

To programme these options scroll down to menu item 5 “Set Units” and press
ENT. Use the ENT key to progress through the list and the UP & DOWN keys to
select the required units. Once selected press ENT to store and return to run
mode.

7.9 Setting the Display Options

The user can select the LCD refresh rate and the format of the line 2 display using
the keypad or the software provided. Scroll down the menu to option 6 “Display
Setup” and press ENT. Use the UP & DOWN arrows to select either the LCD
refresh interval or Line 2 Options:

1. Line 2 Options: The information displayed on line 2 of the LCD can be
chosen by the user. The options are Pressure, Temperature, None,
Date/Time or alternating Temperature and Pressure. Use the UP & DOWN
arrows to select the required option and press ENT to store and return to
the main menu.

2. LCD Refresh Interval: The display update interval can be selected from
0.1 to 1.5 seconds. The current setting can be edited using the same
method as described previously. Once edited press ENT to store and return
to the main menu. The default setting is 0.3 seconds.

7.10 Internal Pressure Sensor

The Rapidox 1100LR is fitted with an internal absolute pressure sensor which
monitors small changes in pressure and vacuum inside the sensor head. The
pressure will normally be ambient absolute (e.g. 1013 mbar) under normal
operation but if the unit is being fed by a gas cylinder or connected to an
apparatus under partial vacuum then the pressure will change and this will have a
direct effect on the oxygen partial pressure and the sensor reading. You have the
option of displaying the pressure reading on the LCD display (1). Select no. 6
“Display Setup” and press ENT. Select “Line 2 Options” using the UP & DOWN
arrows and press ENT. You can set the display to read Pressure or None. Select
Pressure and press ENT. The display will now show the absolute pressure reading
from the internal sensor. If you want to view different units select no. 5 “Set
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Units” from the menu and press ENT three times to reach the pressure screen.
Use the UP & DOWN arrows to select mbar, bar, torr, psi or kPa and press ENT.
The display will now show the pressure in the selected units.

7.11  Pressure Mode

The user has the option of using the reading from the internal pressure sensor to
automatically correct for changes in gas pressure and hence oxygen pressure. To
access this function scroll down to menu option 7 “Pressure Mode” and press
ENT. The desired mode can then be selected using the UP & DOWN arrows and
pressing ENT to store and proceed. The two modes available are:

1. None: If this mode is selected then there is no pressure correction
performed on the oxygen reading. The pressure and oxygen sensor act
independently, and the oxygen reading will vary with the gas pressure.

2. Auto: This is the factory default setting. If the Auto mode is selected then
the Rapidox 1100LR uses the reading from the internal pressure sensor to
correct the oxygen partial pressure and maintain an accurate concentration
reading.

7.12  Setting the Baud Rate

If you are using the software for data logging you can choose the communications
speed (Baud Rate) by scrolling down the menu to option 8 “Set Baud Rate” and
using the UP & DOWN arrows to select 9600, 57,600 or 115,200. Press ENT
button again to store and return to normal operation. The default factory setting is
115,200. However if you are using an older PC you can decrease this to 57,600 or
even 9600 to improve the reliability of the software and data communications.

7.13 RS232 / RS485 Port

The data communications port is normally configured to RS232. It is also possible
to factory set the data communications port to RS485. Once configured at the
factory it is not possible to change unless the unit is returned to Cambridge
Sensotec Ltd.

Data from the Rapidox is sent on demand to the 9-way 'D' type socket (7) on the
rear panel and can be read using a simple terminal programme such as
'HyperTerminal' in Windows, or with the user's own custom software.

Alternatively a simple and convenient data logger programme is included with the
supplied software and is described in section 9 below.

7.13.1 RS232 Protocol

Rapidox data can be read from the RS232 port at the back of the unit. The default
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RS232 configuration is 115200-8-N-1, as shown in this example for COM1:

Communicatians Part (COM1) Properties ==

| General | Port Settings | Driver | Details | Resources|

Bispersecond 176200 =]
i
Fowcontrol: [Nons =]

| Advanced... | | Restore Defaults |

s |

Figure 4: Rapidox default COM properties box

Alternatively, the baud rate can be reduced to 57,600 or 9600 via the “Set Baud

Rate” menu item, using the front panel keypad on the Rapidox. This setting is
stored in EEPROM.

Connection: Connect to RS232 socket at the back of the Rapidox using a 9 way D-
type plug. Signals are as follows:

Rapidox D-type Socket: PC/PLC:

Pin# 2 = Data Out > Data In (RX)
Pin# 3 = Data In < Data Out (TX)
Pin# 5 = Common/Gnd  -- Common/Gnd

HOWHOO
OOOE

RS232

Figure 5: Rapidox RS232 pin configuration

All other pins (1,4,6,7,8,9) = Don’t care
Reading Data: Data is read using command “D”. Send the single character “D” to

the Rapidox. The Rapidox replies with one of the following responses. All valid
responses end with [CR] & [LF] (where [CR] = ASCII 13 and [LF] = ASCII 10).

Response: !Initialising[CR][LF]
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Meaning:  Rapidox is still initialising
Response:  !User setup active
Meaning:  The configuration menu has been activated via the front panel

keypad. The menu will automatically time out 30 seconds after the
last key was pressed, or press the keypad’s ESC key to return
immediately to normal run mode.

Response:  !Possible sensor fault

Meaning:  The sensor has failed to reach operating temperature within 10
minutes from power up. This may be due to the age of the sensor, or
because a high thermal conductivity gas is being used.

Response:  !No sensor or sensor fault|CR][LF]
Meaning;: Sensor is not connected, or there is a fault in the sensor

Response: d9.959E+04,1.426E+02,2.000E-03,2.610E4+01,23:19:40,14/11/10,
ALM1&2,0[CR][LF]

Meaning:  “d” means data is being sent
“9.959E+04” is Oxygen reading in ppm

“,” = data separator

“1.426E+02” is Oxygen sensor reading in mV

“,” = data separator

“2.000E-03” is the internal pressure sensor reading in bar (gauge)

“,” = data separator

“2.610E+01” is temperature sensor reading in °C

“,” = data separator

“23:19:40” is Rapidox time — ignore this

“)” = data separator

“14/11/10” is Rapidox date in DD/MM/YY format — ignore this

“,” = data separator

“ALM1&2” means that both alarm conditions 1 and 2 exist **

“,” = data separator

“0” is an integer indicating a sensor fault code: 0 = no faults

[CR] = ASCII 13 (Carriage Return character)

[LF] = ASCII 10 (Line Feed character)

** If no alarm conditions exist, this data is empty, so the response would look
like:

d9.959E+04,1.426E+02,2.000E-03,2.610E+01,23:19:40,14/11/10,,0[CR][LF]

Response: 7
Meaning:  “D” command was not recognised. Try to send it again.

7.13.2 RS485 protocol

Please contact Cambridge Sensotec for further information on this feature.
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7.14  Setting the Date & Time

The date and time can be programmed either using the software programme or
from the menu on the analyser itself. Scroll up to menu option 9 “Set Date/ Time”
and press ENT. The current date is displayed as e.g., ‘Date: dd/mm/yy’ with the
flashing cursor under the ‘yy’ parameter. Note that the exact format will depend
on the country you are in and the regional options setting of the PC you have used
to connect to the analyser. So for example in the USA you would see ‘Date:
mm/dd/yy’ instead. The prompts at the bottom of the screen indicate what to do:
use the UP and DOWN arrow keys to change the value above the flashing cursor
and press ENT to progress. The cursor always starts under the year value as this
will dictate how the months behave e.g., during a leap year.

Once the date has been set, the display will change to show ‘Time: hh:mm:ss’ with
the flashing cursor under the ‘hh’ parameter. Once all the values are programmed
correctly press ENT to return to the run-mode screen. Note that if you
reprogramme the date and time using the software then this will overwrite any
changes you have just made and will use the current date and time of the PC.

7.15 Replacing the Oxygen Sensor

The oxygen sensor fitted to the 1100LR has a life expectancy calculated in terms
of how much electrolyte is remaining in the cell. The electrolyte is a liquid that
slowly dries out over time. This especially happens in dry gases (most low O,
gases will probably be like this) where it is normal to get 12 to 18 months life from
a cell. In humid applications this may be as much as five years however so these
following warnings are just a guide. The cell is held in a metal housing and it is
possible to replace it yourself. Please ask Cambridge Sensotec for advice. Once
the cell is replaced go to menu option 2 “New Sensor” and press ENT whereupon
you will see a message saying “Fit New Sensor in X days”, where X is a number
showing how many days are remaining. The next screen says “New Sensor?” If
you have just replaced the sensor then press ENT to confirm or ESC to leave the
menu. This will give a message confirming “New Sensor Confirmed” and the on-
board countdown clock will set itself to 365 days, based on the current date.

Note that when the sensor countdown is <60 days to zero the start up screen will
display “Fit New Sensor in X days” for 1.5 seconds as a reminder. At <30 days
the start-up screen message will hold for 3 seconds and will be accompanied by
two beeps as an additional reminder.

Finally, for the benefit of units that are never switched off, when the countdown
clock reaches <30 days a flashing “*” will appear next to the “O,” on the display.
If this is ignored and the countdown reaches 0 the “*” will no longer flash. To
remove this warning, replace the sensor and reset the countdown using menu
option 10.
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7.16 Printing

If you have purchased the printer option then you can print data from the analyser
straight on to thermal paper. Simply connect the printer to the serial socket on
the rear of the Rapidox and make sure the printer is switched on (battery and
mains versions are available). To print the live values on the LCD at any time
simply press the RIGHT arrow button on the front panel. Each press of the button
will print out the serial number followed by the data in a tabbed format followed
by a blank line. If the button is held down, the printer will keep printing data (but
not the serial number).

When the printer is first connected or turned on, a “start-up” message like the one
displayed on the LCD when the Rapidox is switched on will be printed, and will
look like this:

Cambridge
Sensotec Ltd
Rapidox 1100LR
Oxygen Analyser
S/N: 2100942
FW v 01.03.03.01

7.17 Load Defaults

If you make a mistake while programming the Rapidox it is possible to restore the
machine back to its factory calibration and settings by loading the unique original
configuration file that is supplied on your software CD-ROM. This can be
accessed using the software provided (please see section 8.4 for further details).

Alternatively, you can reset to ‘generic’ factory defaults directly from the front
panel keypad. Press ENT to enter the user setup menu and select menu option 11
“Load Defaults” and press ENT to proceed. The next screen will say “Load
Defaults?” with the prompt to press and hold ENT for 2 seconds to confirm. To
complete this press the ENT button until the bar graph has completed and the
screen says “Defaults Loaded”. This will give you all the basic settings that are
factory set. You will now need to re-calibrate the sensor and check all the settings
are suitable.
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8. Rapidox Software Instructions

8.1 Software Installation

It is possible to programme a range of variables to the Rapidox using an RS232 (or
RS485 if configured) link with a PC running MS-Windows (all versions) and the
supplied Rapidox software. The software is installed automatically by inserting
the Rapidox CD into the CD-ROM drive. If auto-installation does not start then
you can click the Windows START button and select RUN. Type ‘X:\setup.exe’
where X is the drive letter of your CD. Alternatively access the CD from Windows
Explorer or the ‘My Computer’ icon on your desktop, and double-click on the
‘Setup.exe’ programme. Follow the on-screen instructions to install the
programme onto the hard drive. Once installed, you can access the programme by
clicking START - PROGRAMS - Rapidox Software.

The software has been tested successfully on most language machines including
Chinese, Korean & Japanese and all current versions of Windows operating
system. We do not recommend the use of Vista as connecting USB to serial
converters to this operating system can be problematical at best.

Note that software is ‘regionally aware’ and will therefore accept and display data
using the decimal separator that is set in the PC’s Regional Settings in the Control
Panel. For example, in the UK or US, you might enter the value 2.5 - in
continental Europe this would normally be entered as 2,5 assuming the PC’s
Regional Settings have been set up to use ‘,” as the decimal separator.

8.2 Getting Started

Make sure that the Rapidox is connected to a free serial port on the rear of your
computer and is powered on. These will nearly always be COM1 or COM2 but the
software will scan through the ports until it finds the Rapidox. The analyser must
be switched on for this to succeed and while you are communicating with it. On
start up the software will locate the Rapidox and display the following page:
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43 Rapidox Software - Connected to SN:21065535 = ot e
File Comms Units Utilities Data Logger Help
l Config 2 ] Alarm Config | Data Acquisition | Diagnostics ] Fwf 01.03.03.01 1841142010 10:01:45
Read ‘white
Ouypgen Fange |High High \i=]
Oxygen Unitz |ppm ppm =}
Temperature Unitz |°C “C hd
Fressure Units |mbar mbar hd
Fressure Comection Mode |Aut0matic - Automatic =}
Operating Mode |N0rmal Marmal \i=]
Auiliary Qutput Pararmeter |Temperature Temperature v |
LCD Refrezh Interval |D.33 0.3 hd
LCD Second Line Option |F'ressure Pressure hd
Pump Flow Rate | ot are hd
Fazzword Protection |Disabled |Disable j
Fazzword | s |
Status

Figure 6: Configuration 1 page. Note the actual values used may differ from those shown above.

The yellow ‘Status’ box at the bottom will display confirmation that the Rapidox
was found and the result of the last action, or any error messages if there is a
problem with communication. If you experience problems check that your serial
cable (supplied) is correctly fitted to a valid serial port. Also check the status of
your COM port settings in Device Manager accessed by clicking START — Settings
- Control Panel. If your PC does not have a serial port, you can use a USB to
RS232 adapter — please contact Cambridge Sensotec if you would like advice
about selecting one.

8.3 On-Screen Help

You can access the on-screen help facility at any time by clicking on the ‘Help’
menu on the menu bar and select the ‘Contents’ option, or alternatively press F1.

8.4 Configuration Page

The configuration page is split into three, and you can switch between them by
clicking on the tabs labelled ‘Config 1’, ‘Config 2’ or ‘Alarm Config’. Each page
allows the user to reprogramme an array of parameters used by the Rapidox. Once
written to the Rapidox, the new parameters remain permanent until overwritten.

To read the current configuration stored in your Rapidox select ‘Read Analyser
Configuration’ from the ‘File’ menu, or click the ‘Read’ button on any of the
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‘Config’ pages. Note that the entries in the boxes on the RHS (under the ‘Write’
button) will turn red if the value is different to that just read and a red asterisk
will appear next to the ‘Write’ button to warn you that a change has been made.
The left-hand set of grey text fields (‘read fields’) will be updated with the current
configuration data. To save this information (e.g., if several people share the same
instrument) click the long copy (‘>>’) button (between the ‘Read’ and ‘Write’
columns) on any of the ‘Config’ pages in order to transfer the data into the edit
boxes, select ‘Save Configuration as’ from the ‘File’ menu and choose a filename.
This data set can be subsequently reloaded at any time by selecting ‘Load
Configuration File’ from the ‘File’ menu and then selecting the folder where the
configuration files have been stored.

If at any time you wish to restore the Rapidox to its factory default settings select
‘Default Configuration’ from the ‘File’ menu to load these values. The software
will search for a unique ‘.rxc’ file which is loaded onto the PC during the software
installation. The filename is ‘XXXXXXX.rxc’ where ‘XXXXXXX’ is the unit’s
serial number, which can be found on the rear of the machine. The original copy
of this file is also on the CD-ROM that came with the analyser. Normally this file
is automatically copied to the main Rapidox folder, but if the software cannot
locate it then it will ask you for the serial number to help it search. The ‘rxc’ file
will be loaded into the ‘Write’ columns, and the software will then automatically
perform a ‘Read’ to update the data in the ‘Read’ columns in order to highlight the
differences between the current configuration (in the ‘Read’ columns) and the
settings from the file (in the “‘Write’ columns). If you wish to proceed with the
reconfiguration simply click any of the three ‘Write’ buttons to reprogramme the
Rapidox.

The right-hand set of white editable text fields (‘write fields’) is used to enter new
values to be programmed into the Rapidox. The values in these fields can either
be entered manually, or copied across from the ‘read fields’ by clicking the vertical
‘>>’ (copy) button, and then edited as required, however greyed boxes under the
‘Write’ buttons are not editable as they contain calibration data; they can only be
changed by copying data across from the ‘Read’ fields. Note that when you click
on the copy button all three ‘Config’ pages are updated at the same time and there
is no need to repeat the action when you toggle to another page. Alternatively,
you can load saved configuration data by selecting ‘Load Configuration File’ from
the ‘File’ menu and selecting the required file. In order to programme the analyser
select “Write configuration to analyser’ from the ‘File’ menu, or click the ‘Write’
button on any ‘Config’ page.

8.5 Reconfiguring the Analyser

The on-screen edit boxes contain variables that can be reprogrammed into the
Rapidox in exactly the same manner as using the front panel keypad. For a full
description please refer to the relevant section in this manual.

The user can choose whether to use ppm or percent notation to edit the O, text
boxes, where appropriate, by selecting the “‘Units’ menu and clicking on ‘Percent’
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or ‘ppm’. To access a field, either click inside it or use the TAB key to scroll
through the fields. The field parameters are as follows:

8.5.1 Config 1 Screen

1) Oxygen Range: Not available for the Rapidox 1100LR

2) Oxygen Units: See Section 7.8 for a full description. Use the drop down
box to select AUTO% or PPM. The default setting is AUTO%.

3) Temperature Units: See Section 7.8 for a full description. Use the drop
down box to select °C or °F.

4) Pressure Units: See sections 7.8 for a full description. Use the drop down
menu to select MBAR, BAR, PSI, TORR or KPa as the unit for pressure
measurement. The default setting is MBAR.

5) Pressure Correction Mode: See section 7.11 for a full description. Use the
drop down menu to select NONE or AUTOMATIC. The default setting is
AUTOMATIC.

6) Operating Mode: Not available for the Rapidox 1100LR

7) Auxiliary Output Parameter: Use this menu to select either PRESSURE or
TEMPERATURE as the parameter sent to the auxiliary output on the rear
panel of the analyser.

8) LCD Refresh interval: Use the drop down menu to select a refresh rate for
the LCD (min 0.1, max 1.5 sec). The default is 0.3 seconds.

9) LCD Second Line Option: See section 7.9 for a full description. Use the
drop down menu to select Pressure, Temperature, None, Date/Time or
alternating Temperature and Pressure.

10)  Pump Flow Rate: See section 7.3 for a full description. Use the drop down
menu to select a pump flow value from 10 to 100% or OFF.

11)  Password option: See section 7.4 for a full description. The password is
factory disabled and set to ‘0000’. Use the drop down menu to enable or
disable the password feature and the password box “****’ can be used to
enter a new password. Note that you will be prompted to enter the original
password if you wish to make changes to the password or its status.
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8.5.2 Config 2 Screen
43 Rapidox Software - Connected to SN:2101234 = et
File Comms Units Utilities Data Logger Help
Config 1 Corfig 2 | Alam Config | Data Acquisition | Diagnostics FAw1.03.04.08 | 16/03/2011 16:43:53

02 Calivation gas 1 (%] [1 [1

D2 Calibration gas 2 [%] o [0
Calibration constant & [1295.5 [1295.5
Calibration constant B o |o

02 Analogue out high: 100/ 20mé, = (%] |1 > |‘I

02 Analogue out low: O/ 4mé = %) |U |D

Aug Analogue out high: 10WA20ma, = [7C) |50 |50
Aux Analogue out lowe: 0V/4méd, = [°C) |D |D
Factory pressure offset [mbar) |1 mz L |1D1 2
Expected Sensor Life Remaining [0 ays) 19634

Status

Figure 7: Configuration 2 page. Note the actual values used may differ from those shown above.

12)  Calibration Gas 1, 2: These boxes are greyed out in this version and the
data is for information purposes only. If you want to change the current
calibration gas then follow the procedure given in section 8.7.

13)  Calibration Constant A & B: These boxes contain the calibration constants
that the Rapidox calculates automatically when you perform a calibration.
You will see that they change each time you perform a new calibration.

14) O, Analogue Outputs (0V/4mA & 10V/20mA): Use these two boxes to set
the High and Low oxygen values for the analogue outputs (6) on the rear
panel. For example if you want 0V/4mA to represent 1ppm and 10V/20mA
to represent 1000ppm then enter these two values into the appropriate
boxes. The value can be entered either in % or ppm depending on the units
selected. The default values are 10000ppm for the high setting and Oppm
for the low setting.

15)  Auxiliary Analogue Outputs (0V/4mA & 10V/20mA): Use these two boxes
to set the High and Low auxiliary values for the analogue outputs (6) on the
rear panel. This can be set to Pressure or Temperature. For example if you
want 0V/4mA to represent 0°C and 10V/20mA to represent 50°C (for
temperature) then enter these two values into the appropriate boxes. The
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units are determined automatically according to the sensor type.

16)  Factory Pressure Offset: This value is preset in the factory to fine tune the
on-board pressure sensor and is just shown for information purposes.
Please ignore this value as it is fixed for the life of the analyser.

17)  Expected Sensor Life remaining: See section 7.15 for a full description.
This value is for information purposes only and can not be adjusted. It
shows the number of days remaining from a countdown starting at 365
days. Once the countdown reaches 0 the sensor should be replaced
although this does depend to a degree on level of use and the humidity of
the gases exposed to the sensor.

8.5.3 Alarm Config Screen
48’ Rapidox Software - Connected to SN:21063535 = X
File Comms Units Utilities DataLlogger Help
Config 1 ] Config 2 Alarm Config | Data Acquisition | Diagnostics FAef 01.03.03.01 18/1/2010 09:57:0
Wirite |
Alarm 1 [High]
Alarm Source |D2 oz j
Alarm Outputs |off oif |
Audible Alarm |of off |
Wisible Alarm [On On |
Rising or Falling Alarm |Faling Faliing hd
Contacts Mormally Open or Mormally Clozed |DDen Open hd
Alarm 1 Set Point [ppr] |U |D
>>

Alarm 2 [Low]
Alarr Source |D2 0z hd
Alarm Outputs |fo 0ff |
Audible Alarm |fo aff =}
Wisible Alarm |On On |
Rizing or Falling Alarm |F|ising Rizing hd
Contacts Narmally Open or Hormally Clozed |UDen Open hd
Alarm 2 Set Point (ppm] |1 oooo 10000

Statuz

|

\

Figure 8: Alarm configuration page. Note the actual values used may differ from those shown
above.

18)  Alarm Source: Use the drop down box to assign a detector to the alarm. If
you want the alarm to be based on oxygen readings select oxygen from the
drop down list. The choices are: oxygen, pressure or temperature.

19) Alarm Outputs: This option enables or disables the alarms on the rear
panel (labelled Alarm High +/- and Alarm Low +/-). Make sure these are

enabled if you wish to use the signals from the alarm circuit.

20) Audible Alarm: This option enables or disables the audible buzzer fitted to
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the Rapidox internally. When an alarm condition occurs the buzzer will
emit a continuous noise to alert the operator.

21)  Visible Alarm: This option enables or disables the visual warning on the
front LCD. When enabled and an alarm condition occurs the message
“AL1” or “AL2” (or both) will flash in the lower right hand corner.

22)  Rising or falling Alarm: This option allows the alarm to be set as a rising or
falling type. If the alarm is rising then the reading must rise above the set-
point for the alarm to be activated. If the alarm is falling then the reading
must fall below the set-point for the alarm to activate.

23)  Contacts N/O or N/C: This option allows the user to programme how the
relay contacts are set on the rear panel. “Normally Open” means that the
contacts are open circuit when an alarm is not activated and “Normally
Closed” means that the contacts are closed when the alarm is not activated.

24)  Alarm Setpoints: Use this box to programme the set-point value at which
you want the alarm to activate. The units are in %, ppm, °C or mbar
depending on which sensor you have assigned to the alarm.

Once you have finished editing the parameters, select ‘Write Configuration to
Analyser’ from the file menu or click the ‘Write’ button on any configuration page
and the new data set will be written to the Rapidox. The Rapidox is
reprogrammed using the new configuration. The software then reads the new
settings back from the Rapidox and displays them in the boxes on the left-hand
side confirming that the configuration was successful.

8.6 On-Screen LCD

It is possible to display an LCD emulator on the desktop of your PC. This
reproduces exactly the display on the Rapidox unit and is convenient if you are
some distance away from the machine. To activate the LCD select the ‘Utilities’
menu and select the ‘Show LCD’ option. This will display a small window
showing the LCD that can be positioned independently anywhere on the desktop.

45 Rapidox LCD ot S
995%pm 02 ©
1.Bmbar v

Figure 9: On-screen LCD

The blue LED indicator will flash to show that the display is updating. To close
the LCD either click its window close button, or click the ‘Utilities’ menu on the
main programme window and select the ‘Hide LCD’ option.
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8.7 Remote Calibrating

With the on-screen LCD display active it is possible to remotely calibrate the
analyser. Click on the down arrow icon in the bottom right-hand corner of the
LCD display to expand the window:

[ 4 Rapidox LCD ) |
9980ppm 02 @
1. Bmbar

| Eiibrate High 63 |

Calibrate Low 02 ‘

Replace Sensor ‘

Figure 10: Remote calibration and replace sensor function

Use the two buttons to calibrate the sensor directly from the PC. Before
calibrating make sure that you know the exact O, concentration in your gas bottle
AND you have a calibration certificate from the gas supplier confirming the
concentration. You can calibrate the analyser in any order but remember that the
gas value for O, High must be greater than the gas value for O, Low. Allow
sufficient time for the calibration gas to pass over the sensor and let the reading on
the LCD stabilise. This is extremely important to perform a successful and
accurate calibration; especially at low ppm values where it can take several hours
for a stable reading.

The software uses the two calibration gas values already stored in the Rapidox as a
starting point. These are typically High = 1%, and Low = 0.001% as set in the
factory but may be different if the user has recalibrated with other gas values in
the past. Either way you are given an option to change the cal gas value before
proceeding to the actual calibration.

Assuming you are using 1% to calibrate O, High then simply click on the button
labelled “Calibrate High O,” to see the following:

Rapidox =)
High02=1%7
Yes Ne | Cancel ‘

Figure 11: Calibration Gas Confirmation Screen.

If the current stored value is correct and matches your cal gas value then simply
click “Yes” to proceed. If you are using a different value to the one you see on the
screen then click “No” to change it as shown below:
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Update gas concentration

Concentration of High 02 calibration gas as %
Cancel

Figure 12: Calibration Gas Update Screen.

Enter your new value in the units as instructed and click “OK” to proceed. This
value will then be stored until you want to change it again. You will now see the
following screen:

Recalibration

About to recalibrate High 02 with 1. %. Are you sure?

Figure 13: Calibration Confirmation Screen.

This is your final chance to change your mind before committing to a calibration.
Check carefully that the gas value on the screen actually matches the value of your
calibration gas before clicking on “Yes” to complete the calibration. At this point
you should observe that the LCD display will reset itself to the correct calibration.
You can now proceed with the rest of the calibration process by selecting the
Middle and Low gases in the same manner.

8.8 Calibration Error Messages

During the calibration process described in 8.7 above it is possible to receive
screen error messages as described here.

1) Bad Sensor Reading: The Rapidox software makes a prediction of the
expected sensor mV for each calibration gas value entered. If the mV signal
coming from the sensor is out of the expected range the following message
is displayed:

Bad Calibration

Sensor mV reading aut of range.
l Continue callbrat\on anyway?

This normally indicates one of two things: that you are using the wrong cal
gas value compared with the actual gas flowing over the sensor OR the
sensor is getting old and can no longer output the expected signal required
for a healthy calibration.
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2) Bad Pressure Reading: The Rapidox software checks to see what the gas
pressure is before allowing the calibration to continue. If the pressure is
outside the range -25mbar to +25mbar (gauge) then the following message
is displayed:

Bad Calibration

Gas
! Contmue callbratmn anyway

This normally indicates that you are allowing gas from a cylinder set at too
high pressure to enter the analyser. Try displaying the pressure reading on
the second line of the LCD and adjusting the gas regulator to trim it close to
0 mbar. If you are using a standard gas regulator then try switching off the

sample pump on the rear of the analyser OR better still use a demand flow

regulator and allow the gas to enter the analyser from the draw of the

pump.

3) Faulty Pressure Sensor: If the pressure sensor is faulty or giving
unexpected signals then if you attempt to calibrate the oxygen sensor whilst
in AUTO pressure correction mode you will get a fault message and the
Rapidox will refuse to continue with the calibration:

Rapidox ===
.'Q\ Pressure sensor fault, Calibration cannot continue

Please contact Cambridge Sensotec to advice. If you need to use the
analyser in the meantime please disable the pressure correction function
(see section 7.11) and you can continue to calibrate and take readings.

Note that 1) & 2) above are only advisories and you can proceed with the
calibration if you believe everything is checked and correct.

8.9 Replacing the sensor

The sensor in R 1100LR has a life expectancy based on the amount of oxygen that
it is exposed to, so sensor life is approximately 12-18 months on average. The
Rapidox will warn you after one year of installation that the sensor is due for a
change. Please see section 7.15 for a full description.

The method for replacing the sensor in the R 1100LR is described in a separate

manual provided with the new sensor. Once the sensor has been replaced and the
unit switched on please register the new sensor using the following procedure.
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Referring to Figure 10 click on the button labelled “Replace Sensor”. The
following message will appear:

Replace sensar

About to register sensor as new. Are you sure?

Figure 14: New Sensor Confirmation Screen

If you are replacing the sensor before the recommended due date the following
screen will warn you about this:

Replace sensor

Sensor still has 365 days before it should need replacing. Replace anyway?

Figure 15: Premature sensor change check screen

Click yes to proceed and register the new sensor. This will reset the 365 day
countdown clock.

8.10 Software Utilities

The utilities menu is located on the main file menu as shown below:

Connected to SN:2101234

Utlhtles Data Logger Help

I Set date and time ics ] Fwi 01.01.09.12

Check For Updates

Read
V| ShowlCD A |
H Hide LCD P “ﬁ

Image Grab 3 Main Form
Calibrate LED 1
XY Plot

constant B
- il =

Figure 16: Software Utilities Menu

8.10.1 Setting Analyser Date and Time

The current date and time of your PC are displayed on the configuration screen
and can be loaded into the Rapidox by selecting the Utilities menu and clicking
the ‘Set date and time’ option. This information is used in the RS232 data string
for data logging purposes. Make sure that your PC clock is set correctly before
using this function, as you cannot edit the date and time shown by the Rapidox
software. The date and time formats displayed are those set in the PC’s Regional
Settings.

Version 1.6 28 Last printed 16/11/2011 16:53:00



Cambridge Sensotec Rapidox 1100LR Oxygen Analyser Instruction Manual

8.10.2 Check for Updates

This function will check online and advise you if any software updates are
available for your machine. This function is not automatic. To update the
software please visit www.cambridge-sensotec.co.uk and select the support page
where a list of downloads are provided.

8.10.3 Image Grabber

This is a simple function to allow the user to copy the software screens into the
Windows clipboard. This is useful for diagnosing problems; allowing a quick and
simple way of sending the Sensotec technicians actual screen shots of the
software. To recover the images simply press CTL+V to paste.

9. Rapidox Data-Logging Software

9.1 Introduction

The Rapidox software includes a full data logging facility. Data can be saved to a
file automatically at regular intervals and the format is compatible with modern
spreadsheet programmes such as MS-Excel. A live-time graphing facility is also
included which has many powerful features. Note that the data logging facility
will only function if the analyser is in NORMAL run mode, and will be suspended
automatically during start up or if the set up menu has been activated via the front
panel keypad.

9.2 Setting up the Data Logger

Click on the tab labelled ‘Data Acquisition’ to display the following page:
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45 Rapidox Software v7.0.10 = LX)
File Comms Units Utilities Datalogger Help
Corfig 1 ] Corfig 2] Alarm Config  Data Acquisition Diagnostics]
Seconds |02 my 02 ppm Pressmbar | Temp*C | Time Date Status
3248 345 2.412E+1 5.000E +0 2B30E+1 182357 1112000 7 j
3247 34 2.380E+1 5.000E +0 2B90E+1 182358 112000
3248 343 2.400E+1 5.000E+0 2530E+1 182353 1As2mo v
3249 343 2.403E+1 5.000E +0 2B830E+1 182400 11122000
3250 342 2.394E+1 5.000E +0 2B830E+1 182400 112000
3251 343 2.393E+1 5.000E+0 2830E+1 182402 1A2m0 7
3282 342 2.388E+1 5.000E +0 ZE00E+1 182403 11122000 7
3253 343 2.396E+1 5.000E +0 2B830E+1 182404 11122000 7
3254 342 2391E+1 5.000E+0 ZE00E+1 182408 1112000 7
3285 34 2.376E+1 5.000E +0 2B30E+1 182406 11122000 7
3256 343 2.397E+1 5.000E +0 2B30E+1 182407 11122000 7
3287 a4 2.388E+1 5.000E +0 2B30E+1 182408 11122000
3258 343 2.397E+1 5.000E +0 2B30E+1 182408 11122000
3259 34 2.379E+1 5.000E +0 2B30E+1 182410  11As2000
3260 342 2.396E+1 5.000E +0 2B30E+1 182411 11200 -
Fead every |1 Seconds | Time Limit  [vw
Run for 1 Minutes | SavetoFile [
Time: left Auta Date Stamped Files [~
Started at Show Plot v
Stops at [rata Count
[ .
Statuz
|

Figure 17: Data Logging page

During logging, data from the analyser is shown in the central area of this page.
The data is displayed in the following columns: elapsed time (in seconds, minutes
or hours), the raw signal from the sensor amplifier (in mV), the oxygen value (in
ppm scientific notation), pressure in mbar, the temperature (in °C), the current
time, the date (in regional format), and status (displaying the word ‘ALMXx’ if any
alarms are activated).

To start data logging select the frequency of measurement by entering a time and
selecting a unit from the drop down list next to the ‘Read every’ label. For
example if you wish to log data once every minute, type ‘1’ in the box and select
‘Mins’ from the drop down menu.

You can open the NOTES window at any time by selecting ‘Notes’ from the ‘Data
Logger’ drop down menu. A small text box appears in which you can type a text
message. This note is then saved as a header in the data file set and can be viewed
along with the data.

You can either choose to have data logged continuously until ‘Stop’ is selected
from the Data Logger menu, or you can choose to set a time limit for data logging
by checking the box labelled ‘Time Limit’, setting the duration in the ‘Run For’ box
and selecting units with the drop down list. For example if you wish to log data
for thirty minutes type ‘30" in the box and select ‘Mins’ from the drop down list.
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9.3 Running the Data Logger

If you wish to save the data into a file for later use, check the ‘Save to File’ box
before selecting ‘Run’ from the Data Logger menu. You will be prompted for a file
name and location before data logging commences. The file and path information
will appear in the box at the top of the page labelled ‘Data File Name’. If you
forget to select file saving before starting a run, you will nevertheless be prompted
at the end as to whether you wish to save the acquired data.

The blue progress bar displays the state of completion of the run, and the blue box
to the right of it the same information as a percentage. You can stop the run at
any time by selecting ‘Stop’ from the Data Logger menu. The yellow ‘Status’ bar at
the bottom of the page gives information about the data logging operation.

Once data logging is complete you may open the text format data file using any
compatible spreadsheet programme such as MS Excel, and use the data to
generate plots and reports.

You can pause the data logger at any time by selecting ‘Data Logger’ and ‘Pause’.
Click ‘Data Logger’ and ‘Resume’ to continue logging from where you left off,
noting that the clock keeps ticking during the pause period.

9.4 Auto Date Stamped Files

If you are planning to run the data logger for extended periods of time then you
should consider checking the ‘Auto date stamped files’ option. This feature will
save the data at midnight for the previous twenty four hours and so on until the
data-logging is complete OR the user interrupts. The data file is stored as a set of
files, each with a date suffix in brackets in yyyy-mm-dd format.

This feature ensures that data is saved periodically in sensible sized files. This
will prevent the computer from crashing and will also ensure that the data is small
enough to fit into an Excel spreadsheet

As an example, the user wishes to run the data-logger for seven days recording
every minute starting at lunchtime on 12th November 2005. He starts the data
logger with the auto-date stamp function enabled. When prompted he gives the
filename as ‘test1’. In this situation the data logger will run from lunchtime to
midnight and then save the first file as ‘test1 (2005-11-12).txt’. The data logger
then clears and continues for another twenty four hours until midnight the
following day. The data is then stored as ‘test1 (2005-11-13).txt’. This will
continue for seven days when the data-logger will finish.

After this the user will have a sequence of files:
test1 (2005-11-12).txt

test1 (2005-11-13).txt
test1 (2005-11-14).txt
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And so on. Combined together they represent all the data over the last seven days.
Note that the Rapidox uses the computer clock and date to perform this action, so
make sure that they are correct before starting a run.

To view the data in its entirety the user would, for example, need to load each file
in turn back into Excel to combine them.

9.5 Live-time Graphing Screen

The Rapidox data-logging package includes a live-time graphing facility that
allows you to monitor the progress of your data in a graphical format (see Figure
18). To access the graph check the box labelled ‘Show Plot’. The graph will
appear in a new window, and can be accessed at any time without disturbing a
run that is already in progress. You can select ‘Run’, ‘Pause’ and ‘Stop’ from the
‘Data Logger’ menu on the ‘Rapidox Plot’ window to begin, pause and end data
logging, and the window can be minimised to (and restored from) the task bar
while logging data.

To close the window and return to the main data-logging page select ‘Close Plot’
from the ‘File’ menu or click on the close window button. You can also close the
plot from the main window by un-checking ‘Show Plot’. The features of the graph
window are described below:

4’ Rapidox Plot = 3
File View Datalogger Help
Flot coordinates Cursaor 02 axis
Time: 0
1 22208 he il ppm 02 0 ppm 02
1 1250 Bresans: 0 Linear
ppm 02 Pressure(mbar]
1250 50

1125 45

1000 40

375 35

B -

750 an
625 25
500 20

75

250

125

= e

—————t———— e ——— e ——Fu
250 500 750 1000 1250 1500 1750 2000 2250 2500
Time[Seconds)

]

=

Figure 18: Live-time graphing screen
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9.6 Main Graph Window

The graph is an XY plot, with time plotted on the X-axis, oxygen plotted on the
primary Y-axis (Y1) and pressure or temperature plotted on the secondary Y-axis
(Y2). The X-axis and the two Y-axes auto-scale during data logging so that all data
points are shown on the graph. You can select what is shown on the Y2 axis using
the ‘View’, ‘Second axis display’ menu.

9.7 Plot Colours

The default colours used on the graph are set to blue for oxygen and red for
pressure r temperature. To change the colours double-click on the coloured axis
label at the top of each axis. A colour palette window will appear and a new
colour can either be chosen from a colour box, or for more variety, by clicking the
‘Define Custom Colors >>" button. Click on ‘OK’ to select the new colour or
‘Cancel’ to return to the graph without change.
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Figure 19: Plot colour palette menu

9.8 Graph Titles and Labels

If you want to change the text of the graph axis labels, place the mouse pointer
over the text and do a single left click to enter edit mode. The text can then be
modified. Similarly, to change the title of the graph, place the mouse pointer over
the title and click once to edit. If you choose not to enter a title the graph will
display the path and filename of the run as the new title once the run has
finished. Note that these changes are only temporary and will be overwritten by
the defaults if a new run is started or the graph window is closed and reopened.
They are provided so that the plot may be printed with alternative labels.

9.9 Plot Co-ordinates

The box labelled ‘Plot co-ordinates’ to the upper left of the graph window displays
the actual plot co-ordinate value at the mouse pointer. This can be used to get a
quick oxygen value from the graph. Simply place the mouse pointer at a place of
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interest and read the corresponding X1 and Y1 values in the box.

9.10 Last data point

During data acquisition, the box labelled ‘Last data point’ will appear at the upper
middle of the graph window. It displays the most recent data values read from the
analyser.

9.11  Using the Cursor

Clicking and holding the left mouse button with the pointer over the {@® at the top
of the plot area activates the cursor, which appears as a vertical dashed line on the
plot. While keeping the mouse button pressed, you can now move the pointer
anywhere in the plot area or on the {® in order to move the cursor. The box
labelled ‘Cursor’ to the upper right of the graph window will display actual values
for oxygen, temperature (or pressure), time and the data point number (n) at or
immediately to the left of the cursor position. The cursor can be used to
investigate actual data values at specific points of interest on the graph. The
cursor is not available during data acquisition, but is available if the run is
‘paused’.

9.12 Zooming

You can zoom in to any part of the oxygen plot by simply placing the mouse
pointer on the new graph start position and then clicking and dragging a new box
to re-size the graph. The label on the box to the upper left of the graph window
will change to ‘Zoom box co-ordinates’, and an extra set of co-ordinates, labelled
X2 and Y2, will appear, showing the co-ordinates in X and Y units of the second
corner of the zoom rectangle as you drag the mouse pointer. The plot will zoom
and auto-scale when you release the mouse button. This can be repeated if you
wish to zoom in even further. To zoom back to the original size select ‘Zoom Full’
from the View menu. Note that although you can use the zoom facility during a
live run, the graph will auto-scale to full size with each new data point.

9.13  Y-Axis Graph Units

You can toggle the Y1 oxygen units at any time from percent to ppm and vice
versa. Select ‘O2 Units’ from the ‘View’ menu and choose either ‘Percent’ or
‘ppm’. The current selection is then displayed in the top right box labelled ‘02
Axis’.

9.14 Oxygen Scale

You can display the Y1 oxygen axis in linear or logarithmic format at any time by
selecting ‘O2 Scale’ from the view menu. The current selection is then displayed
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in the top right box labelled ‘O2 Axis’. Note that the zoom function is disabled
when you are viewing on a log scale.

9.15 Second Y Axis

The secondary Y axis located on the right hand side of the graph can be used to
display either the pressure taken from the internal pressure sensor or the gas
temperature. The axis is linear and auto-scaling. To select the mode of the
secondary axis select the “‘View’ menu followed by ‘Second axis display’. Choose
from ‘None’, “Temperature’ or ‘Pressure’.

9.16  Loading an Old Run

A previously logged data file can be loaded and viewed by selecting ‘Open Data
File’ from the ‘File’ menu and selecting the appropriate TXT or CSV file. A
progress bar is displayed while the data is being imported. Note that very large
data files may take several seconds to load. The data is re-graphed and you can
zoom, label axes, change colours etc., before printing the graph.

9.17  Printing Graphs

You can print the graph at any time by selecting ‘Print Plot’ from the File menu.
This will bring up the printer dialogue box for your specific printer where you can
choose various printing options. Make sure that the printer page is set to
landscape to obtain a full size print out.

9.18 Data Logging in the Background

It is possible to begin data logging and then minimise the windows to continue
working with another application. To minimise the graph simply click on the
minimise button on the blue title bar at the top of the window. You can then use
the ALT + TAB keys to take you to other programmes already running. To return
to the graph simply maximise from the start menu bar or press ALT + TAB again.
If the graph does not redraw immediately select ‘Zoom Full’ from the View menu
to redraw.

9.19  Pausing the Data Logging

You can pause the data-logging at any time during the run by selecting the ‘Data
Logger’ menu and selecting ‘Pause’. Repeat the action and click on ‘Resume’ to
continue, noting that the live graph will draw a straight line between the paused
points to keep continuity of the axes. The clock keeps ticking during the pause
period.

If you decide to access the menu of the Rapidox using the front keypad during
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data logging, then the software will pause automatically. A message appears on
the screen informing the user that the unit is being accessed from the keypad.
Once the menu has been exited, the software will continue data logging from
where it left off.

9.20 Changing the Data Logging Parameters Mid-run

Once the data logging has begun you may change the sample interval time by
pausing the data logger and then entering a new value for the time interval. The
data logger can then be resumed with the new values in place. Note that you can
not change units (e.g., seconds to hours) once logging has started. If you originally
selected seconds then you may change the current value to a new value between 1
and 3600 seconds, if you originally selected minutes then you may change
between 0.02 and 360 and if you selected hours you may change between 0.01 and
6 hours. Note it is not possible to modify the original total length of time that the
data logging will run for once a run has commenced.

9.21  Working with Spreadsheets

The data-logger saves data files in a standard comma separated ASCII text format
which can be readily imported into spreadsheet programmes such as MS Excel, in
order to produce plots and reports as desired. For specific information on how to
import text files into your spreadsheet programme please refer to the help guide
supplied with the programme.

Data is saved in comma separated value format, with a ‘.txt’ file extension as the
initial programme default. However, when entering the file name, you can instead
select a ‘.csv’ extension: the programme will register the last used file extension as
the new default. The ‘.csv’ extension is recognised by MS Excel, so that opening
the file will automatically run MS Excel, and this may be of benefit if your
regional decimal separator is period ‘.’ rather than comma ‘,;’. However, if your
decimal separator is comma, you should continue to use the ‘.txt’ extension and
open the file explicitly from within your spreadsheet programme, defining the
field delimiter as ‘comma’ where appropriate.

9.22  Disaster Recovery

To prevent catastrophic loss of important data during a computer crash or power
failure, the data is automatically saved point by point in a temporary file called
‘Rapidox temporary data file XXXXXXX.txt’ (where ‘XXXXXXX’ is the serial
number). This file is located in the same directory as the main Rapidox
programme itself and can be renamed or copied to recover data that would
otherwise be lost. Note that this file is overwritten each time ‘Run’ is selected
from the ‘Data Logger’ menu so make sure all data is recovered successfully before
starting another run.

Note that during a run using the ‘auto date stamped’ feature, the temporary data
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file is wiped clean as soon as the previous data set has been saved successfully. In
the case of a crash the temporary data file should be used to recover the last day’s
worth of data that was not saved to the hard disc.

9.23 Diagnostics

The Rapidox software includes a diagnostics page that is accessed from the tab
labelled ‘Diagnostics’. This screen will display various values and settings that are
operating inside your machine. There is no editing possible on this page — it is
purely for information and to enable technical support help you should you
experience difficulties with your machine. You may be asked to record values
from this page if trouble shooting is required.

4’ Rapidox Software - Connected to SN:2101234 = K e
File Comms Units LUtilities Data Logger Help

FAVO1.01.0913 | 19072011 141041

Analogus Sensor State Drigital

Diata 0: D 02 Senzon W Data: | 32

Data 1: ’W Auxl Sensor: W

Data 2 ’w Aux2 Sensor: ’W Sehan

Data 3 ,70 Temp Sensar: W

Data 4 RE

Data & I

Data B 430 Temperature Sensor:

Data 7 e ]

Data & [ amE

Diata 9 [0

Diata 10 [ Em0

Data 11: ’7850

Log Diagnostic Data [

Acquisition data:
|2.854E +05,-1. 364E +01 1. 861E+00,,00:43:12,01,/01/00,...0

Statuz

|F|eading diagnostic data fram R apidosx

Figure 20: Rapidox Diagnostics Page

1. Analogue: The live analogue values displayed in this pane are voltage
measurements coming directly from the computer chip inside the analyser.
They are for information purposes only but are a useful diagnostics tool for
Sensotec staff, as unusual values can indicate a particular fault. To help
Sensotec diagnose a fault please capture this window as shown above using
the screen capture function described in section 8.10 above and e-mail it to
support@cambridge-sensotec.co.uk

2. Sensor State: These boxes should all indicate “OK” on a healthy analyser.
The possible messages are “OK” “High” “Low” or “Fault”. The High and
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Low messages indicate that the sensor is out off normal range. The fault
message will only display if the sensor is disconnected or has failed in some
way.

3. Digital: The digital signals coming directly from the computer chip inside
the analyser can be monitored here. To test the keypad is working correctly
try pushing the buttons and watching the panel. A correctly functioning
key will turn the box red on the screen and the digital value for that
particular key will show in the data box. If the analyser has an external
thermocouple correctly fitted (2100 and 3100 series only) then this will
display a signal in the “Temperature Sensor” box.

4. Log Diagnostic Data: Checking this box will allow the software to log the
diagnostic data which can then be e-mailed to Sensotec for analysis. Do not
switch to a different tab while logging diagnostic data — the data is only
logged while the “Diagnostics” tab is still selected. The software will log
diagnostic to a file named “Rapidox diagnostics file 210xxxx.txt” (where
“xxxx” is the serial number of the analyser) in the folder shown in the
yellow “Status” box at the bottom of the screen. Data is logged every 6
seconds, so the software should be left to run for at least 1 minute to gather
a few data points. In order to stop logging, simply uncheck the “Log
Diagnostic Data” tick box. Note that diagnostic data is always saved to the
same file, and will automatically overwrite any existing file without
prompting the user, so if you want to save existing data you must either
rename it or copy (or move) it to a different folder, before checking the “Log
Diagnostic Data” tick box again. If you are logging diagnostic data during
the analyser’s warm up period, the “Acquisition data:” box will display the
current sensor heating message, and will only display acquisition data once
the oxygen sensor has reached its operating temperature.

Once completed please e-mail this file to support@cambridge-
sensotec.co.uk for analysis.

10. Troubleshooting

The Rapidox says 'O/Range' and won't begin measuring.

The sensor is not designed to measure oxygen above 10,000ppm so if the
machine has been switched off for a long time or the tubing has been
exposed to oxygen rich gas then please wait a while for the low oxygen gas
to flush through. After several minutes the message should clear and the
unit will start to take measurements.

> Q2

The Rapidox won't power up at all.

There are fuses located on the power socket on both live and neutral lines.
These are standard 20mm 2A slow blow fuses available from a supplier
such as RS Components.

>

Q: The Rapidox gives strange readings that are way off the expected values.
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A: Check to make sure which calibration gases are selected. Are they the same
as the actual gases you used to perform the calibration? If not you must
recalibrate the analyser or re-load the factory defaults to get you going
again. Also check to see that the pressure correction mode is set to AUTO
and that the ambient pressure is set correctly.

Q: I messed up the calibration procedure and the analyser is not working
properly.
A: Return the unit to the factory defaults using the keypad or communications

software, by selecting ‘Default Configuration’ followed by ‘Write
Configuration to Analyser’ from the File menu. Now try re-calibrating the
Rapidox.

The software will not talk to the Rapidox.

Make sure that you are using the correct cable, as supplied (pin 2 to pin 2
etc). A crossed RS232 cable (pin 2 to pin 3 etc.,) will not work. Make sure
that your COM ports are recognised by your computer. Check in your
Windows device manager to see if there are any conflicts. If you have an
internal modem fixed to your PC you may experience difficulties using this
software. Contact Cambridge Sensotec for further advice.

> Q2

Q: I selected ‘Write to the Analyser’ and now the Rapidox is way off
calibration.

A: Only select ‘Write to the Analyser’ once all the values are correctly entered
in the boxes on the right. The best procedure is to ‘Read Analyser
Configuration’ and then press ‘Copy’ so the values in the boxes are the same
as those stored in the Rapidox memory. You can then edit these values and
then select “Write to the Analyser’ when finished.

How do I get back to the factory calibration for my instrument.

Select ‘Default Configuration’ from the ‘File’ menu and load the default ‘rxc’
file from the Rapidox software programme folder on your PC, or look for the
default ‘rxc’ file on your CD. Select this file and then select ‘Write to the
Analyser’. This will load the factory calibration back into the Rapidox.
Alternatively you can load a standard default configuration any time using
the "11-Load Defaults’ option from the user menu which is accessed via the
front panel keypad. This configuration will not be perfect for your analyser
but will be good enough to get you started again.

>0

11. Warranty

The Rapidox analyser has been carefully tested and inspected before shipment
and is guaranteed to be free from defective materials and workmanship for a
period of twelve months from date of purchase. The sensor head is replaceable
and has a life expectancy of one year approximately. However, if the analysis gas
contains corrosive gases or large quantities of particulates, sensor life may be
shortened. In the case of the latter, it is normally possible to insert a filter prior to
the sensor head to remove the particulate material.
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11.1  Conditions of Warranty:

1) This warranty is in addition to and does not affect any statutory rights of
consumer purchasers. This warranty is valid worldwide on a “back to base basis”.

2) This warranty covers breakdowns due to design or manufacturing faults; it does
not apply to damage, however caused, wear and tear, neglect, unauthorised
adjustment or repair, or any items of limited natural life.

3) In the event of failure, please take the following action:

a] Refer to the “Troubleshooting” section of your instruction manual to
identify and possibly correct the problem.

b] If the fault cannot be resolved, please contact the Cambridge Sensotec
service and repair centre at the address given on the cover of the manual.

4) The warranty period applicable shall be 12 months from the date of delivery
provided that:

a] Notice in writing of the defects complained of shall be given to Cambridge
Sensotec (The Seller) upon their appearance, and

b] such defects shall be found to have arisen from the Seller's faulty design,
workmanship or materials, and

c] The defective goods shall be returned to the Seller's premises at the
Purchaser's expense if so requested by the Seller.

d] Any repaired or replaced goods shall be redelivered by the Seller free of
charge to the original point of delivery but otherwise in accordance with and
subject to these Conditions of Sale.

e] Alternatively the Seller shall be entitled at its absolute discretion to refund the
price of the defective goods in the event that such price shall already have been
paid by the Purchaser to the Seller, or, if such price has not been so paid, to
relieve the Purchaser of all obligation to pay the same by the issue of a credit note
in favour of the Purchaser in the amount of such price.
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APPENDIX 1: MENU FLOWCHART FOR RAPIDOX 1100L

gogpg 02 < Back to Measurements : Changes Applied
.Ombar
' | I ESC - Back to Menu List. No changes }
ENT
A A4
1-Calibrate _ENT Calib: 02 High L ENT 4.000E+04ppm L ENT) 4.000E+03ppm 02 4.000E+03ppm 02
(prompts 1) (prompts 2) (prompts 3) Calib. 02 High 02 calibrated
-ESC
T‘L Edit 02 High Enter for two seconds to calibrate Displays message for 1.5 seconds
T¢ Calib: 02 Low L ENT 0.000E+00ppm LENTS 0.000E+00ppm 02 0.000E+00ppm 02
T (prompts 2) (prompts 3) Calib. 02 Low 02 Calibrated
Edit 02 Low Enter for two seconds to calibrate Displays message for 1.5 seconds
2-New Sensor L EnTo] Fit New Sensor New Sensor? | ENT New Sensor
| £sc (prompts 1) in 5 Days (prompts 7) <« Confirmed
Ti/ Displays message for 1 second Confirm Displays message for 1.5 seconds
N
3-Set Alarms | ento] Set: Alarm 1 [ enTo] Assign to: 02 | enTo] Outputs: On L ENT—
Esc (Prompts 1) (Prompts 2) (Prompts 2) (Prompts 6)
(Options: Alarm 1, Alarm 2) (Options: Oz, Temp., Press) . (Options: On, Off)
Audible: On | eyt Visible: On | ento] Polarity: T | EnNT—
(Prompts 6) (Prompts 6) (Prompts 6)
Ti/ (Options: On, Off) (Options: On, Off) (Options: ™)
T 1.000E+01 | cnro] Contacts: N/o - Contacts: N/O
(Prompts 3) (Prompts 6) Alarm 1 set
Edit Alarm Setpoint (Options: N/O, N/C) Displays message for 1.5 seconds
4-Set Outputs L ENT _0.000E+00 = OV L ENTS 1.000E+04 = 10V L ENT Aux out: Press. L ENT
(prompts 1) (prompts 3) (prompts 3) (prompts 6)
~ESC
Edit O2(ppm) Edit O2(ppm) (Options: Press. Temp.)
_0.000E+00 = 0OV L ENTo 1.000E+02 = 10V | ENT 1.000E+02 = 10V
(prompts 3) (prompts 3) Outputs set

Continues on page 2

Edit press(mbar) or Edit temp(°C)

Edit press(mbar) or Edit temp(°C)

<

Back to Menu List : Changes Applied

Displays message for 1.5 seconds




o Back to Measurements.

Continued from page 1

| | Esc - Back to Menu List. No changes }
N
5-Set Units Oxygen: Auto % Temperature: °C Pressure: bar Pressure: bar
—ENT-) -ENT ) ~ENT- ~ENT-> )
| Esc (prompts 1) (prompts 6) (prompts 6) (prompts 6) All units set
T¢ (Options: Auto %, ppm) (Options: °C,°F) (Options: bar, torr, kPa, mbar, psi) Displays message for 1.5 seconds
N
6-Display Setup | ENT Line 2 options L ENTS L2:Pressure LENT L?: Pressure
| roc (prompts 1) (prompts 2) (prompts 5) Line 2 set
Ti{ (Options: Pre§sure, Temperature, None, Displays message for 1.5 seconds
Da-te/hme, Alternate T/P)
N Refresh interval L ENT Interval: 0.3 s | ENT Interval: 0.3 s
L (prompts 2) (prompts 5) LCD refresh set
Change the value 0.1-1.5s Displays message for 1.5 seconds
7-Pressure Mode Mode: None Mode: None
~ENT. ~ENT -
ESC (prompts 1) (prompts 5) Mode configured
T¢ (Options: Auto, None) Displays message for 1.5 seconds
AN
8-Set Baud Rate LENT Baud rate: 115200 | ..+ Baud rate: 115200
| Esc (prompts 1) (prompts 5) Baud rate set
T¢ (Options: 9600, 57600, 115200) Displays message for 1.5 seconds
AN
9-Set Date/Time | -7 Date: 07/08/10 | -nTo] Date: 07/08/10 | enTo] Date: 07/08/10 | ENT—
| Esc (prompts 1) (prompts 6) (prompts 6) (prompts 6)
Set Year Set Month Set Day
N Time: 16:38:10 | Nt Time: 16:38:10 L ENT Time: 16:38:10 L ENT ) Time: 1_0:55:30
(prompts 6) (prompts 6) (prompts 6) Date/time set
N
Set Hours Set Minutes Set Seconds Displays message for 1.5 seconds
10-Set Pump Flow L ENT Pump Flow: 90% | ENT Pump Flow: 100%
| eoc (prompts 1) (prompts 5) Pump flow set

Continues on page 3 ‘\

Use UP & DOWN arrows to select pump speed

N

Back to Menu List : Changes Applied

Displays message for 1.5 seconds

N



OBacktoMeasurements mContinuedfrompageZ {‘ 4ESC - Back to Menu List. No changes'ﬁ 4{
A
- ?
11-Load Defaults | enT] LO2d Defaults? | ENT Detaults loaded
| sc (prompts 1) (prompts 7)
Ti/ Enter for two seconds to load defaults Displays message for 1.5 seconds
A
12-Password Menu | enT] Password: Q0% | N7 Password: Enable | EnT Enable o Disable selected Password: Enable
ESC (Prompts 1) (prompts 3) (prompts 2) PW Enabled
Enter password - default is 0000 (Options: Enable, Disable, Change) Displays message for 1.5 seconds
Password: 6234 LENT—> Password: 6234
'N« (prompts 3) PW Changed
Edit password Displays message for 1.5 seconds
c < Back to Menu List : Changes Applied
Wraps around to Page 1
Prompts 1: Prompts 2: Prompts 3: Prompts 4: Prompts 5: Prompts 6: Prompts 7:
T = Scroll Menu ™ = Scroll Menu E : sC:f:(?f Char ENT = OK ™ = change ™ = Change ENT for 2s = OK
ENT = Next ENT = Next ENT = OK ’ ESC = Back ENT = OK ENT = Next ESC = Back
ESC = Exit ESC = Back ESC = Back ESC = Back ESC = Back
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